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WELCOME

Congratulations on purchasing your Visioneer USB flatbed scanner. 
With your scanner, you can quickly scan paper documents and color 
photos to place their electronic images on your computer.

WHAT’S IN THE BOX

Before starting the installation, check the contents of the box to make 
sure that all parts are included. If any items are missing or damaged, 
contact the dealer where you purchased the scanner. 

Note:  The CD also includes the PaperPort User’s Guide, the manual 
for the PaperPort software. You can print a copy from the CD to your 
printer.

Software CD Installation Guide Power cord USB cable

PaperPort USB Scanner
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WHAT YOU NEED 

To use the scanner and software, you need the following:

• IBM PC (or 100-percent compatible) Pentium or equivalent 

• Microsoft Windows 98

• One available Universal Serial Bus (USB) port on your computer

• 16 megabytes (MB) or more of available internal memory (RAM)

• 35 MB of free hard disk space

• A VGA or SVGA monitor. Recommended settings for your monitor 
are as many colors as possible—High Color (16-bit), True Color 
(24-bit or 32-bit). Set the resolution to at least 800 by 600 pixels. 
To set your monitor’s colors and resolution, open the Windows 
Control Panel, double-click Display, and then click the Settings tab.

• A CD-ROM drive

GETTING THE PAPERPORT USER’S GUIDE

The CD also includes your PaperPort Getting Started Guide and 
PaperPort User’s Guide. These guides provide more detailed information 
about PaperPort’s features. Please see the CD to view these guides. 
You can also print these guides from the CD.
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THE SCANNER
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Document cover. Close the document cover after placing items on the scanner glass.

Document pad. Helps to secure the document in place on the scanner glass.

Glass. Place items face down on top of the glass, in the upper left corner.

Reference frame. Place items face down within this frame. Both inches and centimeter 
markings appear along the border of the frame.

Button. Previews scan or starts PaperPort software if it is not running.

Universal Serial Bus (USB) port. Plug one end of the USB cable into this port, plug the 
other end into the computer’s USB port.

Power jack. Plug the scanner power cord into this jack.

Note:  The scanner does not have an on/off switch. Simply start the PaperPort 
software and click the Twain button. For more information, see “Setting Up the 
Scanner” on page 7.
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GETTING HELP

The PaperPort software includes a complete help system that answers 
questions about the scanner and its software. If you have questions or 
the scanner doesn’t seem to work correctly, please use the help.

To get help while using the PaperPort software:

• Press the F1 key, or from the Help menu, choose PaperPort Help 
Topics to display the Help Topics window.

INSTALLING THE PAPERPORT SOFTWARE

The PaperPort CD includes all the PaperPort software files.

The CD also includes the PaperPort User’s Guide, the manual for the 
PaperPort software. You can read the guide while the CD is running, or 
print a copy directly from the CD to your printer.

To install the PaperPort software:

1. Start Microsoft Windows 98 and make sure that no other 
applications are running.

2. Insert the PaperPort CD into your computer’s CD-ROM drive. 
The CD automatically starts.

Note:  You must install the PaperPort software before you install the 
scanner. Otherwise the correct scanner driver will not be installed and 
your scanner will not work properly. 
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3. Follow the instructions on the screen to install the PaperPort 
software on your computer. Later, after the scanner is working, 
you can install the other applications provided on the CD.

CONNECTING THE SCANNER TO YOUR COMPUTER

The PaperPort scanner connects to any available USB port. Check your 
hardware manual for the USB port location. 

To connect the Visioneer scanner:

1. Plug one end of the USB cable into an available USB port. 

2. Plug the other end of the USB cable into the USB port on the back 
of the scanner.

If the plug does not attach easily, make sure that you are plugging it 
in correctly. Do not force the plug into the connection.

3. Plug the power adapter cable into the jack on the Visioneer scanner.

Note:  If the PaperPort CD does not automatically start, make sure the 
CD drive’s door is completely shut. If the CD still doesn’t start, click 
the Windows 98 icon that shows the drives on your computer. 
(Usually, the icon is named My Computer.) The window shows the 
drives available on your computer. Double-click the icon for your 
CD-ROM drive to see the list of files on the CD. Double-click the file 
named START.EXE. The CD starts. 

Note:  You do not have to shut off the power to your computer when 
connecting the Visioneer USB scanner. 
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4. Plug the power adapter into an AC (wall) outlet. 

The power-on light on the front of the scanner comes on indicating 
the scanner is receiving power.

The following diagram shows the cable connections to a computer 
with a USB port.

5. A progress dialog will appear saying the USB scanner has been 
found. 

Note:  The power-on light remains lit when the computer is turned 
off. This is normal even though the computer is turned off. 

Power cord USB Cable
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SETTING UP THE SCANNER

The steps to set up the scanner identify the type of scanner you have and 
prepares the PaperPort software to scan with it.

To set up the scanner:

1. If the PaperPort software isn’t currently running, double-click the 
PaperPort icon on the Windows desktop to start it. The PaperPort 
Desktop appears. 

2. From the File menu, choose Select Source. The Select Source 
dialog box appears, listing all Twain devices installed on your 
computer.

3. Choose the Visioneer Scan Manager, and then click Select.

Your scanner is now set to scan with the PaperPort software.

Note:  You don’t need to complete Steps 2 and 3 again, unless you 
change the selected source to another Twain device.
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SCANNING AN ITEM

The following procedures explains the basic steps for scanning an item 
either using the button on the front of the scanner or by selecting the 
Twain icon in PaperPort.

You can scan many types of items, from small business cards to A4-sized 
pages. The Visioneer scanner also has special settings for scanning color 
photos and fine print (like the fine print on a contract). For more 
information about scanner settings, see “Adjusting Scanner Settings” on 
page 11.

Using the scanner button:

1. If the PaperPort software isn’t currently running, press the button 
on the scanner. The PaperPort Desktop appears. 

2. Open the scanner cover, place the item you want to scan face down 
onto the upper left edge of the scanner glass, and close the cover. 

3. Press the button on the scanner. 

The Visioneer Scan Manager dialog box appears.

If you click the button again, this only previews the item. To scan 
you must click the Scan button on the Visioneer Scan Manager 
dialog box. 

Note:  Your scanner is preset to scan color images. Selecting a new 
scanner setting to scan in black and white reduces the scan time and 
also produces smaller files for the scanned images. The steps below 
explain how to select new scanner settings.

Note:  For additional details about the Scan Manager’s features, click 
the Help Button in the Visioneer Scan Manager.
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Using the Twain icon in PaperPort:

1. If the PaperPort software isn’t currently running, double-click the 
PaperPort icon on the Windows desktop to start it. The PaperPort 
Desktop appears. 

2. Open the scanner cover, place the item you want to scan face down 
onto the upper left edge of the scanner glass, and close the cover. 

3. Click the Twain icon on the PaperPort software’s Command Bar, 
or choose Acquire from the File menu. 

The Visioneer Scan Manager dialog box appears.

Note:  For additional details about the Scan Manager’s features click 
the Help Button in the Visioneer Scan Manager.
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USING THE VISIONEER SCAN MANAGER

1. Select the area of the item you want to scan.

When you preview an item to scan, the selection rectangle around 
the image indicates the scan area. However, you may want to select 
only a certain area of an item to scan. Selecting an appropriate scan 
area can result in a faster scan and a smaller file size.

To select the area you want to scan, drag the borders of the selection 
rectangle surrounding the preview image to reduce or enlarge the 
area.

2. Check the preview image. If you want to change the scanner setting 
for the item, click one of the options in the list to “Scan Page For.” 

For example, to scan a black and white image instead of a color 
photo, select Black & White Photo in the list. 

See the table in the section “Selecting a Predefined Scanner Setting” 
on page 12 for a description of these predefined settings.

3. Drag the selection rectangle around the item to resize the area the 
scanner scans.

Preview the item in 
the preview window. 

Scan the item to the 
PaperPort Desktop.

Preview the item 
before you scan.

If you want to adjust 
the size of the scan ar-
ea, or crop the image, 
drag the borders of 
the selection rectangle 
surrounding the item.

Select a scanner setting 
appropriate for how 
you want to use the 
scanned item.

Use these Scan 
Configuration settings 
only when customizing 
scan settings.
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4. When you are satisfied with the preview item, click the Scan button 
on the Visioneer Scan Manager dialog box to scan the item. 

The scanned item appears in PaperPort.

ADJUSTING SCANNER SETTINGS

You can adjust the scanner settings to fine-tune the scanned item. 
This section tells you how to:

• Select a predefined scanner setting.

• Customize a scanner setting.

• Scan in color.

• Adjust the brightness and contrast.

• Select the area of the item you want to scan.

Thumbnail item
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SELECTING A PREDEFINED SCANNER SETTING

Selecting the proper scanner setting before scanning provides the best 
results for a scanned item. The scanner setting determines the resolution 
of the item and the number of possible shades of gray or color. These 
selections affect the speed of the scan and the file size. The Visioneer 
Scan Manager Dialog gives you the approximate size of the scan.

In the Visioneer Scan Manager dialog box, you can select one of the 
predefined scanner settings from the list “Scan Page For.” The settings 
are described in the following table. 

Scan Page For Default Setting To Scan Description

Faxing, Filing, 
or Copying

Black-and-white
200 dpi

Newspaper and 
magazine articles, 
receipts, forms, and 
other text items

Provides the fastest scan time 
and smallest file size.

Editing Text 
(OCR)

Black-and-white
300 dpi

Business letters, 
contracts, memos, and 
other documents that 
you want to edit

Enhances the use of OCR 
software for converting item 
text to editable text. Provides 
higher quality and a larger file 
size than the Faxing, Filing or 
Copying scan setting. 

Black & White 
Photo

Grayscale
100 dpi

Black-and-white photos Provides the best setting for 
black-and-white photos.

Color 
Document—
Faster

Color
100 dpi

Color pages with many 
graphics, or mixed 
graphics and text, line 
art, or photos that 
require a quick scan

Creates a reasonable scanned 
color item in a file that is not 
too large. PaperPort’s default 
setting.

Color 
Document—
Better Quality

Color
200 dpi

Photographs and color 
items

Provides the ideal setting for 
color items, item editing, 
desktop publishing, and high-
quality output. Results in a 
color scan with slower scan 
time and a larger file size. 
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CUSTOMIZING A SCANNER SETTING

You can create up to ten custom settings to add to the list of options on 
the Scan Manager dialog box. 

To create a new scanner setting:

1. Click the Twain icon on the Command Bar, or choose Acquire 
from the File menu. The Visioneer Scan Manager dialog box 
appears. 

2. In the Scan Page For options, select Custom to create a new 
scanner setting.

You now use the options in the Scan Configuration section to 
customize the setting. Please refer to the figure on page 10.

3. Click the Advanced Settings button. The Advanced Settings dialog 
box appears.

4. Drag the slider bars for the brightness and contrast to set those 
features for the new setting.

5. Click Close to return to the Visioneer Scan Manager dialog box.

6. Click the Save As button.

The Save As dialog box appears.

Note:  Predefined settings can not be customized.
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7. Type a name for the new scanner setting. 

8. Click OK.

The new setting is added to the list of “Scan Page For” options at the 
top of the dialog box. 

SCANNING IN COLOR

Your PaperPort scanner is initially set to scan Color Document—Faster. 
To scan at a higher resolution, select Color Document—Better Quality. 

To scan in color: 

1. Do one of the following: press the Button on the scanner, click the 
Twain icon on the Command Bar, or choose Acquire from the 
File menu. The Visioneer Scan Manager dialog box appears.

2. Click Color Document—Faster or Color Document—Better 
Quality. You can also use these settings for any other color items 
such as color pages from articles.

3. Scan the item by clicking the scan button.

Note:  Scanning at a higher resolution creates a larger file size, takes 
longer to scan, and may not print any better. To minimize the file size 
and the time required to get a better quality scan, select just the area of 
the item that you want to scan. For more information about selecting 
the area of an item, see “Selecting the Area of the Item You Want to 
Scan” on page 16.
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ADJUSTING THE BRIGHTNESS AND CONTRAST

Sometimes an item is scanned with the brightness and contrast set to be 
too light or too dark. For example, a note written with a light pencil 
may need to be scanned darker to improve legibility. 

You can adjust the brightness and contrast at which grayscale and color 
items are scanned. You can also adjust the brightness for black-and-
white items. 

To adjust brightness and contrast:

1. Do one of the following: press the Button on the scanner, click the 
Twain icon on the Command Bar, or choose Acquire from the 
File menu. The Visioneer Scan Manager dialog box appears.

2. Click the Advanced Settings button. The Advanced Settings dialog 
box appears.

3. Click on the Custom button.

4. Drag the Brightness slider to the left to make the item darker or to 
the right to make the item lighter. 

5. Drag the Contrast slider to the left to decrease the contrast or to 
the right to increase the contrast. 

6. Click Close on the Advanced Settings dialog box.

Note:  For more detailed information on advanced features, refer to 
the Help.
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SELECTING THE AREA OF THE ITEM YOU WANT TO SCAN

When you preview an item to scan, the selection rectangle around the 
image indicates the scan area. However, you may want to select only a 
certain area of an item to scan. Selecting an appropriate scan area can 
result in a faster scan and a smaller file size.

To select the area you want to scan, drag the borders of the selection 
rectangle surrounding the preview image to reduce or enlarge the area.

To select the area you want to scan:

1. Click the Twain icon on the Command Bar, or choose Acquire 
from the File menu. The Visioneer Scan Manager dialog box 
appears. 

2. Click the Preview button. An image of the scanned item appears in 
the Preview area. A selection rectangle shows the current scan area.

3. (optional) In the Scan Configuration settings, select the units of 
measure you want to use for the scan area. You can select either 
inches, centimeters, or pixels.

4. Drag the selection rectangle to position it over the area you want to 
scan. 

5. To change the dimensions of the rectangle, click the rectangle, and 
then drag the borders of the rectangle to resize it. This effectively 
allows you to crop the item. The dimensions of the selected area 
appear in the Scan Configuration settings.

You can also type length and width dimensions directly into the 
boxes that show the dimensions of the selection area. Use this 
process to produce a precise scan area size.

6. To reposition the rectangle, click and hold the left mouse button 
and drag to the location desired.

7. Scan the item by left clicking the button on the scan manager.
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CLEANING THE SCANNER GLASS

Scanning items that have excessive amounts of dirt or dust may dirty the 
glass. To ensure the best quality scanned item, wipe the scanner glass 
with a soft clean cloth to rid the glass of dust or other debris.
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PAPERPORT 3100 & 6100 USB SCANNER SPECIFICATIONS

Bit Depth 3100 USB:
30-Bit color (internal), 10-Bit gray (internal), 
1-Bit line art/text

6100 USB:
36-Bit color (internal), 12-Bit gray
(internal), 1-Bit line art/text

Scanning resolution Optical resolution: 
3100 USB: 300 x 600 dpi
6100 USB: 600 x 1200 dpi
Maximum resolution (interpolated):
2400 x 2400 dpi

Maximum Item sizes 8.5 x 11.69 inches (21.6 x 29.7 cm)
Scanner dimensions
Height 3.4 inches (8.5 cm)
Width 11.4 inches (29.0 cm)
Length 17.3 inches (44.0 cm)
Weight 5.7 pounds (2.6 kg)
Operating temperature 50°–104° F (5°–35° C without condensation)
Relative humidity 20%–80% (@35° C without condensation)
Power supply
Input voltage/frequency 100 Vac, 50/60 Hz (Japan)

120 Vac, 60 Hz (North America)
230 Vac, 50 Hz (Europe)

Output voltage/watt 12 V DC, 15 watt maximum
Safety and agency certifications UL, ULc, GS, FCC Class B, 

VCCI Class 2, CE
Hardware warranty One-year limited warranty
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